BIOSTATS 690C — Fall 2020 3. Excel MAC 2016 for Epidemiology Page 1 of 51

Unit 3

EXCEL MAC 2016 for Epidemiology

1

“Technical skills, like fire, can be an admirable servant and a dangerous master.’

- A. Bradford Hill (1971)

Microsoft Excel, MS Excel, is the standard program for creating spreadsheets,
maintaining them, and producing charts. Other programs are available, such as Quattro
Pro or Lotus 1-2-3, but you are unlikely to encounter them.

This introduction to MS Excel focuses on its use for data set creation, manipulation
(eg- sorting and selecting) and selected calculations.

While it can be done, we will not be using MS Excel to do statistical analyses and data
visualizations. The focus of BIOSTATS 690C is, instead, on R and Stata.
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Learning Objectives

When you have finished this unit, you should be able to:

e Navigate in and out of Excel (launch, exit, enter data, format cells, arrange
columns, freeze rows and columns for easy viewing, sort, and autofill);

e Specify the format and layout of an excel spreadsheet for printing (portrait v
landscape, headers, footers, etc);

e Create new fields (what we think of as variables) using functions and user-
specified formulae; and

e C(reate a data set and document it.
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1. Introduction to MS Excel

1.1 What is MS Excel?

MS Excel is a widely used software package used for creating spreadsheets. In Excel spreadsheets are called
worksheets.

What is a spreadsheet? [t is simply a grid of information that might include numbers or words or a mix. Its
storage in a grid is handy way to do its organization.

What might I like to do with a spreadsheet?
Lots of things, actually — lists, sorted lists, picture summaries. Also charts

1.2 Advantages and disadvantages of MS EXCEL

Advantages

o It is very commonly used and very easily shared.

o Many statistical analysis packages permit the direct import of Excel data.

o Data can be sorted by any column while still retaining the integrity of each record.

o It is easy to create new variables that are mathematical functions of variables. For example, you can

tell Excel to calculate the mean of the fields in columns A, B, and C and store the result as a new field,
such as column D.

J Blocks of data can be copied and moved from one part of the worksheet to another or from worksheet
to worksheet.

o Excel offers lots of formats for data display (e.g. — number of significant digits, display of dates as
month-day-year) with no loss of information.
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Disadvantages

o The entry of a negative number is awkward. Excel might interpret the negative sign as the beginning
of a mathematical formula. Solution: enter the negative number with a leading apostrophe * in the
cell, e.g., “-0.28.

o Excel can make mistakes in mathematical formulae if you inadvertently mix character and numeric

fields. For example, if column A is character and Column B is numeric, the addition of entries in
column A and column B may be incorrect.

° Sometimes, the charts produced by Excel are not correct.
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2. Getting Started - Spreadsheet Basics

Launch Excel by clicking on the excel icon on your dock.
\

92 9 \SmaOR T / +Ix

Tip! Begin your session by saving your file:

(1) Upon launching, Excel 2016 offers you a gallery of templates. Select “Blank Workbook™ and click
“Create” at the bottom left. (2) From the menu bar at the top of your screen: FILE > SAVE AS. (3) In the
“Save As” box, enter a name of your choosing; no need to type the extension “.xIsx” Excel provides it. Click
Save. I chose to name my saved file carol _practice.xlsx.

pOO New Workbook ®N Save As: carel_gracticd wisx
— o H [ New from Template... OXP | | Tags
6 = . M Open... ®x0 z =
Take 3 - & Home | Open URL.. ox0 M —
tour - " .‘: = Open Recent > - = Format: | Lxcel Werkbeok (xhw)
’ Jm Sloss ol | :‘(::.:nun--uu( o WA dre Saved o by Gelndt Canset $iere VBA o (aiel 4.0
Pae Save NS & ~ - e e - s e - LAt
- o — Al
g ) . Save as Web Page.., i F|  Loaen mone sbowt e foemuty
N TR s (-
: Import., Oprions... Compatidibty Repoet.. Compat Exity (Pach 16 Crampned
s Share -
L3
= - Z Reduce File Size... Concel | (S
=L % Web Page Preview
10
[} Restrict Permissions >
= Passwords...
0
:: Page Setup...
16 Print Area -
7 Print... nP
s
19 Properties...
o v .
(2}
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The Excel Window - Basics
Note — Your screen may look different depending on what toolbars, ribbons, and icons have been selected for
display.

Excel 2016 for MAC

@ Excel File Ecit Vi sert Format Tools Data Window Help

B carcl_practice

From  From New Ouatase  Aebwih i it F N - T oo Uspeer Sebees
MWL et Guery " . a

A

T Title Bar

: Active Cell ormula Bar

h Sheet Tabs bar

Status Bar

CEBSENRESREDHBYNYUR
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Excel offers three “views”: page layout, normal, and page break review. Choose the view you like
using the icons located at the bottom. \

Normal View
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Again ... Your screen may look different depending on what toolbars, ribbons, and icons have been selected

for display.
@ Excel File Edit View Insert Format Tools Data Window Help
Excel Mac Menu Bar
Quick Access Toolbar Ribbon Ribbon Tabs Formula Bar

Formulas

Workbook

Data Review View

©-

&t Share A

P~ - - » ~Na v (B - X 4 - -
& Wi WA &P Q
Tables llustrations  Add-ins  Recommended -+ ["*~ J &~ Sparklines Link Text Symbols
Charts ' e Commen
Al : fx
A 8 c D £ F G M | ) K L
Quick Access Toolbar Common commands such as “Save” and “Undo”
Ribbon A series of tabs that provide access to tool groups
Formula Bar Shows the contents of cells and is used to compose
formulas.
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2.1 Excel 2016 for Mac Toolbars

In Excel 2016 for MAC you have 3 choices of toolbars: 1) Excel Mac menu bar 2) Quick Access toolbar
or 3) Ribbon.

1) Excel Mac Menu Bar

@ Excel File Edit View Insert Format Tools Data Window Help

FILE, EDIT, VIEW. and INSERT drop down menus:

IGD edit View insert For[Zl View insert Format T(EENN insert Format Tol ISl Format Tools D:

New 3EN Undo Typing 'sdsd'in A1 3#Z v Normal
New from Template... 3P add Page Layout
Open... #0| cut %X
v Ribbon X #R Sheet >
n Recent > i
gee Copy B | v/ Formula Bar Chart ~
Close 38W| Paste RV a
Save %S Paste Special... ~RV | = Ia Bulld
‘ ormula Builder
Save As... CES| m >
Save as Template... | Clear » | Header and Footer... | Add-ins >
- Select All #A Comments
Browse Delete...
Import Sheet > Custom Views...
Find > Zoom... Name B
Reduce File Size... Enter Full Screen ~3F
Start Dictation... >
Share » | Emoji & Symbols  ~%Space | Picture >
Audio >
Always Open Read-Only Movie B
Passwords...
Shape B
Page Setup...
Print Area >
Print... #*P | 3D Models >
Properties... |
—— ——
SmartArt B
|
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Ny Tools Data Winde Al Data Window Hel JEEICH Window Help m Help
Row > Spelling... Sort... ¥R Minimize %M |
Column > hesaurus "R AutoFilter Zoom
Sheet > Smart Lookup... ~"\C88L )
| Advanced Filter... New Window
AutoCorrect... Arrange...
| Subtotals... Hide
Validation... Unhide...
SN
Translate X3 Table... Split
Check Accessibility Text to Columns... Freeze Panes
Consolidate...
Track Changes Group and Outline » Bring All to Front
ﬁrotect.icl'»ﬁ ‘ Summarize with PivotTable ¥ carol_practice
Auditing Table Tools >
Macro Get External Data >
Excel Add-ins...
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2) Quick Access Toolbar
e @ M EH v~ S +~

The quick access toolbar contains common commands. Hover your mouse
(from left to right) to locate the icons for, in order: start a new worksheet

) ically Sa
from a template, save, undo, refresh, and customize access toolbar. VRS

New
v File
More commands can be added to the quick access toolbar by clicking the 4 :::Z o
last icon and check any commands listed in the dropdown or select “More = print
Commands” for more options. Speling
v Undo
v/ Repeat
Note: the Toolbox icon is dropped from Excel 2016 Sort Ascending
Sort Descending
- Formula builder can be found under “View” in the Excel menu bar More Commands.
- Reference tools can be found under “Tools” in the Excel menu bar
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3) Ribbon

A green ribbon is located below the tool bar. Notice 8 headings or “tabs.” “tab” contains groups of
functions that have been organized for easy use.

Home Insert Page Layout Formulas Data Review View Developer |2 Share v

At the far right, notice the down arrow next to “Share”: the arrow is for showing or hiding functions

Home tab
Most frequently used. Contains many familiar commands e.g. — formatting cells, text and
numbers, inserting and deleting columns and rows, and adding formula (near Sort & Filter icon on

the right).

Formulas Data Review Viewn Developer ha
‘. - X ) Calibei (Body) + 12 -‘ A~ Av = BN P %9 Wrap Texz Gereral- . b‘r - [ 4 .-.;:; ?’ é\‘f
. B I U* __+3+.A. = = = o= 6= [G]uegesComars $ % ) %3 2 Ol ot o | Do | @ Mt
Insert tab
Frequently used. Use to format and edit tables created within Excel. Here for pivot tables, too. Also
use to create graphs and charts. Pictures and SmartArt can be added under the Illustrations dropdown
Home Insert Page Layout Formulas Tata Review View Developer
— - e B v (% =
3 A SR g MR G gy W P D A Q-
Pwotlutle Aecommended Tabke  Wustrations B wyrseies - [ Recommendes "_ . Div Meos pretCrar  Spardiees Uk New  Tem Symbots
7 e=a| o Swre
ﬁwlm Ttk  Wuatratons ) Wy Adsns -
% - ) @
Petures Shapes  oors 30 Smariant Screeeshat
Nodels
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Page Layout tab
Frequently used. Use this for page setup, view, margins, orientation, and printing options.

Home Insert Page Layout Formulas Data Review View Developer

Gridines Headirgs

As) + B8 Colors > b - (| - - - Wicth Automatic
(L) — 1 i = = o= Vv view V' view

Themes A3 Fonts + Margins Orientation  Size Print Breaks Background Print  Page I Heighe: Automatic
Area Titles Setup Print Print

Formulas tab
\ Very frequently used. Use to create or build formulas and functions

Formulas Data Review View Developer

fx Z Q - - ' g - E B - Defiee Name * 3 e bcesens (o &y - s~ S comtam a

(% Trace Depencents

nsert AutoSum Recertly Financial  Logical Tent Dote & Lookup& Waths More = Create from Selection - Show Error Calculation | = Caleulate Sh
Functicn Used Time Reference Trg Functions +x Remove ArTows *  Foemulas Checking Options
Data tab

| Very frequently used. Use to actually do things with your data such as: sort, filter, analyze. \
Home Insert Page Layout Formulas Data Roview View Developer
2 Conrections A ~
g o - » 8 AZ Y g g e [ 2 & :
Frem  From New Detabase  Refeesh {4 sem Finr g, Advances Textio  Flash  Remove Data  Consolicane  ‘What-If Greup  Ungroup Subtonal
LET N Quary N . - Columns  Fll Duplicaces Vakdation Aalysis

Review tab
Useful. Use for creating and editing comments, setting permissions, sharing, tracking changes, etc.

Home Insert Page Layout Formulas Data Review View Developer

ABC & + Show ont
v ax @ e La A&
Spelling 1 Translate Chaeck New gl v Noxt Show All Comments Protect  Protect Always Cpen
Accossibiity Comment Sheet Workbook Read-Only
View tab
Useful. Use for selecting or customizing view, freezing panes and, viewing macros.
Home Insert Page Layout Formulas Data Review View Developer
u 1] i v FormaaBa  Zoom 48% . = ' rPOp
(==2 B - -
Nermal Page Break  Page Custom v Grigines v Headings Q Zoom 10 100% Freeze Freoze Froeze First Spin View Record
Preview Layout Views Pares Top Row  Column Macros Macro
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Developer tab
Useful. Use for adding Visual Basic for Applications (VBA) to the workbook and managing add-
ins.
Home Insert Page Layout Formulas Data Review View Developer
[ Abc -
ETS & oA v 8 Z e It
Visual Macros Record  Add-ins  Excel Button Group Combo Label Check Scroll List Option Spinrer
Bosxc Macro Agd-ins Box Box Box Bar Box  Button

Tip! Customize the display of toolbars.

From the Quick Access Toolbar: Down arrow icon B > MORE COMMANDS

a MEwv-&

Page Layout Formulas

v/ Automatically Save

New
« A VFie
= vsave

Send Workbook
Print
Spelling

v Undo

v Repeat
Sort Ascending
Sort Descending

More Commands...
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® Ribbon & Toolbar Ribbon & Toolbar
> Show All Show All Q se
Quick Access Toolbar (T Quick Access Toolbar
All Tabs
Choose commands from: Main Tabs Choose commands from:
Popular Commands v Tool Tabs Popular Commands <
B ' P Customize Quick Access Toolbar:
Y Add or Remove Filters SmartArt Tools Y Add or Remove Filters |4 AutoSave
— Borders v » [ SmartArt Design | AutoSave B | File
™ Calculate Now » B Format __ Borders » | Save
& Center Chart Tools " Calculate Now ) Undo I»
- Conditional Formatting ’ » E Chan Design = Center Text () Repeat
copy > Eromat & Condtions Formating >
+ Custom Sort... Drawing Tools Copy
X Cut » B Shape Format %’ Copy formatting from one locati...
A~ Decrease Font Size Picture Tools 1. Custom Sort...
= Delete Cells... » B Picture Format X cut
! Delete Sheet Columns PivotTable Tools A~ Decrease Font Size
=+ Delete Sheet Rows » E PivorTable Analyze w=x Delete Cells...
* % Email » 8 Design !, Delete Sheet Columns
@ File... Header & Footer Tools =x Delete Sheet Rows
* Fill Color B » [ Header & Footer U Email
Fomt I- Table Tools @ | File
A Fomt Color . » @ Table *| Format Cells
Fomt Size I PivotChart Tools A~ Increase Font Size
& Format §"" j' - += Insert Cells... %
Drog 10 ro-order commands within custom tabs Drag commands into the order you prefer
Cancel Cancel
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Customize RIBBON by 1) Select a tool under a tool group (e.g. SmartArt Design under SmartArt
Tools) on the left and click the add sign at the bottom to create “New Group” 2) Scroll down to find
short cuts to the icons you want on the left, and select. 3) Select a tool group that you want to add a
command to on the right, and click the right arrow in the middle to add.

Ribbon & Toolbar

Show Al
Quick Access Toolbar
Popular Commands
Commands Not in the Ribbon Customize the Ribbon:
v All Commands Tool Tabs %]
Macros
All Tabs SmartArt Tools
Main Tabs » € SmartArt Design
Tool Tabs » EFormat
Custom Tabs and Groups Chart Tools
69 » B Chart Design
23 » EFormat
% 3-D Color Drawing Tools
) 3-DEffects » B Shape Format
3-D Onjort Picture Tools
% 3-D Options.. » @ Picture Format
% 3-D Options.. PivotTable Tools
) 3-D Rotation » » EPivotTable Analyze
A 3-D Rotation . » @ Oesign
"] 3-D Rotation » Header & Footer Tools
4 3-D Rotation Options... » Bl Header & Footer
% 3-D Rotation Options... Table Tools
32 » @ Table
34 PivotChart Tools
2L + &
Drag to fe-order oo s hin custom tabs + — #

New tab
New group

Cance’

Customize QUICK ACCESS TOOLBAR by 1) Scroll down to find short cuts to the icons you want on
the left, and select. 2) Click the right arrow in the middle to add.
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Show All

Choose commands from:
Popular Commands

'Y Add or Remove Filters

| AutoSave

__ Borders

I Calculate Now

= Center Text

| Conditional Formatting
Copy

% Copy formatting from one locati...

1. Custom Sort...

X cut

A~ Decrease Font Size

= Delete Cells...

! Delete Sheet Columns

=x Delete Sheet Rows

U Email

@ File

| Format Cells

A~ Increase Font Size

= Insert Cells...

Ribbon & Toolbar

Customize Quick Access Toolbar:
|4 AutoSave
@ File
| Save
¥ Undo |»
() Repeat

Center Text

FEE

Drag commands into the order you prefer

Cancel

2.2 How to move through cells

Moving through cells in Excel 2016 for Mac is mostly (but not entirely) the same as in versions of Excel for
the PC. One distinction is in moving to a particular cell. See the last row of the following table.

To Get to ....

Key strokes to use are ...

One cell up

up arrow key

One cell down

down arrow key or ENTER

One cell left left arrow key

One cell right right arrow key or TAB
Top of the worksheet (cell A1) CTRL+HOME

End of the worksheet (last cell containing data) |[CTRL+END

End of the row CTRL+right arrow key
End of the column CTRL+down arrow key

Any cell
Example: Cell D4 (column “D”, row “4”)

Step 1: Click in the name box located to the left
of the formula bar (picture below)

Step 2: Type the cell reference, eg; d4

Step 3: Press enter

Data
Management

Data
Collection

Statistical
Analysis

Data
Summarization
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Location of the “name box” — Left of the formula bar. In this picture, the “name box” as in it D4

® 00
PHEHOEH® $ D@ & -
#A Home 1 Layout ] Tables I Charts [ SmartA
D4 0@ (= &l 22
_ [ B8 | C Db & |
1 | 45 56 34 21
[2 | 11 76 22 23
3 23 32 11 44
Ex 45 90 a1 2]
5] 8 7 55 34
6 |
7
Name Box Formula bar
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2.3 How to Modify the Layout of Your Worksheet
As you add data to your worksheet, you may find you need to modify the layout in various ways:

o Widen or shrink rows or columns

o To resize a row: Position your cursor over the boundary line between two rows at the far left of the
worksheet. The appearance of your cursor will change from a little arrow to a cross. Left-click and
drag to obtain the row size you want and then release.

o To resize a column: Position your cursor over the boundary line between two columns at the top of the
worksheet. The appearance of your cursor will change from a little arrow to a cross. Left click and
drag to obtain t he column size you want. Release.

o Highlight a cell or cells
Excel offers some shortcuts for selecting cells:

Cells to select Mouse action

One cell click once in the cell

Entire row click the row label (row number at far left)
Entire column click the column label (column letter at top)

A
click the whole sheet button (triangle _J
shape located in upper left, above row 1
1 and to the left of column “A”) 2

drag mouse over the cells or hold down the SHIFT key while using the arrow
keys

Entire
worksheet

Cluster of cells

° Insert/Delete a row
Your new row will be ABOVE your current location
To Insert: INSERT > ROW
To Delete: EDIT > DELETE. Choose: “entire row”

° Insert/Delete a column

Your new column will be LEFT of your current location
To Insert: INSERT > COLUMN
To Delete: EDIT > DELETE Choose: “entire column”

Design ...... Data  ..... Data ... Data ... Statistical ...... Reporting
Collection Management Summarization Analysis



BIOSTATS 690C — Fall 2020 3. Excel MAC 2016 for Epidemiology Page 21 of 51

o Move or copy cells
Highlight and select the cells you want to move or copy

To move cells: EDIT > CUT
Position cursor in upper left cell of destination
EDIT > PASTE

To copy cells: EDIT > COPY
Position cursor in upper left cell of destination
EDIT > PASTE

. Freeze panes
TIP!!! This is a wonderful feature! It allows you to retain for viewing some “header” rows and
columns. Example — Row 1 might contain variable names and column A might contain study id’s. I
want to be able to always see these, regardless of where I am in the worksheet.

To freeze panes: Position cursor (1) below header row and (2) right of header column
VIEW TAB > FREEZE PANES

To UN freeze panes: Use VIEW TAB > UNFREEZE PANES

o Note — The freeze panes feature is for viewing only. Formatting the printing of a worksheet so that a selection of top
rows and left hand columns appears on every page is done using File > Page Setup > Sheet. More on this later (see
section 2.8).

o Adding, Deleting, Renaming, and Moving Worksheets
At the bottom of your screen you will see a tab for each worksheet: sheetl, sheet2 and so on.

To add a worksheet: Click on the “+” button located to the right of your last worksheet

To delete a worksheet: Locate yourself anywhere in the worksheet to be deleted.
EDIT > DELETE SHEET

To rename a worksheet: Right click on the tab of the worksheet you want to rename.
The tab is at the bottom of your screen.
Choose from menu: RENAME

To move a worksheet: Right click on the tab of the worksheet you want to move.
Choose from menu: MOVE OR COPY
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2.4 Formatting Cells

As previously noted, Excel has formatting options for the display of spreadsheet information so that it is
readable to us! (eg - dates, times, percentages, or dollars! To format cells, columns of cells, or multiple
columns of cells:

(1) Highlight the cells. Typically, you will select an entire column by clicking on the column heading

(2) From the menu bar at top: FORMAT > CELLS
This will open the dialog box below. It has several tabs. You will be positioned in the NUMBER tab

(3) Choose the tab and category that you want to format. Then select from the drop down menus that are

provided. Example — Suppose I want to format this column as US currency with 2 units places for cents. |
also want negative dollar amounts to appear in black with a minus sign in front. See below.

Format Cells

Number  Alignment Font Border Patterns  Protection

Category Sample

General $45.00

Number

L Decimal places: 2
Accounting

Date Currency symbol
Time s

Percentage

Fraction Negative numbers:

Scientific
Text -$1,234.10

Special
Custom

$1,234.10
(§1,234.00)
— ($1.23410)

Currency formats are used for general monetary values. Use Accounting formats to align
decimal points in a column.

{ Cancel ) (0K

T

(4) The other tabs (eg — “Alignment”, “Font” “Border”) can be accessed to change the font of text entries, to
align entries on the right, left, or center of cells, etc. Try it!

Design ...... Data  ...... Data ... Data ... Statistical ...... Reporting
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2.5 Formulas and Functions

The creation of new variables (or fields) that are the result of calculations is easy. Here is a little data set that |
just made up:

1 A | B ] C [ D | E |

-1 |Student gradel grade2 grade3

2 |jane 88 95 79
3 rober 79 S0 77
4 kamil 92 88 83
5 |linda S0 84 65
6 |hua 87 89 76
7 zeke 95 94 88
8 |joshua 82 83 75
9 |

10

Suppose we want to obtain, separately for each student, the average of “gradel”, “grade2”, and “grade3.”

First, we obtain the average for the student whose scores are in the first row. This is ”Jane” and her
scores are in row “2”,

Step 1: Highlight (this makes the cell “active”) the cell where the result is to be stored. This is cell E2.
Note the reassuring blue bold border. To the left of the formula box, you will see E2. Again,
reassuring. The result of your calculation will be put into cell E2.

Home Insert Page Layout Formulas Data Review View Develd
|+ -B-B-B-0-0 808 B8
! Insert AutoSum Recently Financial Logical Text Date & Lookup & Math& More

Function Used Time Reference Trig Functions

E2 v X v fx

A B C D E

1 Student gradel grade2 grade3

2 |jane I T —

3 rober 79 90 77

Design ...... Data  ..... Data ... Data ... Statistical ...... Reporting

Collection Management Summarization Analysis



BIOSTATS 690C — Fall 2020 3. Excel MAC 2016 for Epidemiology Page 24 of 51

Step 2: Click on the FORMULAS TAB icon located in the (green) ribbon.
The formula tab will be opened, showing you several icons related to formulae.

o s} £ carol_practice

Home Insert Page Layout Formulas Data Review View Developer

i X-H-B- R OB-8 8- 08 B
Insert AutoSum Recently Financial Logical  Text Date & Lookup& Math& More
Function Used Time Reference Trig Functions

Step 3: Always begin your calculation with an equal sign, “=”
Position your cursor in the formula box. Type the equal sign.

A 2-H-B- B O-0 8-3 8-

! Insert AutoSum Recently Financial Logical Text Date & Lookup & Math & More

Home Insert Page Layout Formulas Data Review View Developer

Function Used Time Reference Trig Functions
E2 v fx =
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Step 4: Make use of the function average and the use of “select” and “drag” to complete calculation

Type the word average followed by a left parenthesis. Take care that there is NOT a space.
Next - highlight cell B2 (Jane’s score for grade 1)

Next - Using shift key, select and drag to select all three scores: B2, C2, and D2

Now you can type your right parenthesis.

Press enter.

Home

Sx

Insert Page Layout

Irsert AutoSum Recently Financial Logical Toxt Date & Lookup& M
Functicn Used Time Reference
AVERAGE y X + fx =AVERAGE(82:02)|
A B C D
1 Student gradel grade2 grade3
2 |jane | 88 95 79|
3 rober 79 90 77
The result now appears in cell E2:
= Y W 7 7 odl|
A [ Y | e e W e gy [P e
1 |[Student gradel grade2 grade3
2 |jane 88 95 79 87.333333
=1 | rober 79 90 ]
4 kamil 92 88 83
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Replicate this calculation for all the other students.
There are at least two ways to do this.

Approach 1
(1): Highlight (make active) the cell that has the first result; this is cell E2 in this example.
(2): From the top menu bar, choose Copy

(3): Highlight all the destination cells; these will be cells E3, E4, and so
on down to the last row in your data set.

(4): From the top menu bar, choose Paste.

Approach 2
(1): Highlight (make active) the cell that has the first result; this is cell E2 in this example.
(2): Click the bottom right corner of this cell. A little “cross hair” should appear.

(3): Click on the “cross hair” and drag down through E3, E4, etc to the last row in your data set.

Release.
Voila!
E2 '+ @ © [ fx| =AVERAGE(B2:D2)
4 WU WO OO N NN NN WU WONS £ [Wm—-—
1 |[Student gradel grade2 grade3
4 ljane 88 95 79| 87.333333
=1 |rober 79 90 77 82
= kamil 92 88 83| 87.666667
-1 |linda 90 84 65| 79.666667
. |hua 87 89 76 84
"¢ |zeke 95 94 88| 92.333333
22 ljoshua 82 83 75 80
—”
9 | iz
10| -
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MS Excel has hundreds of “Built in” Functions
Excel 2016 for MAC offers easy access, help, and examples.

Click on the icons in the FORMULAS tab on the ribbon bar:

Home Insert Page Layout Formulas Data Review View

Insert AutoSum Recently Financial Logical Text Date& Lookup& Math&

3. Excel MAC 2016 for Epidemiology

F22D RN R - R 2 EAR o B < B © B - B

More
Function Used Time Reference Trig Functions

Page 27 of 51

£l carol_practice

Developer

Excel returns a dropdown of functions in that category:

Home Insert Page Layout Formulas Data Review View Developer AVERAGEA

fx 2 n m n A n ﬂ ﬂ E > Define Name * ::E::gi:;s

Insert AutoSum Recently Financial Logical Text Date & Lockup & Math&

Function Used Time Reference  Trig 2 Statistical > BETA.DIST

£S . S Ld Engineering > BETA.INV
A 8 C D _ ,g l(f::r;auon : SHOM BT

1 Student gradel grade2 grade3 [ Compatibilty > 2::2:‘&'?““65

2 jane 88 95 79 87. B we > CHISOA‘DIST

3 rober 79 90 77 ! | CHSQDISTRT

4 CHISQ.INV

5 :! CHISQ.INV.RT

6 CHISQ.TEST

7 CONFIDENCE.NORM

8 CONFIDENCE T

9 CORREL

10 COUNT

11 COUNTA

12 COUNTBLANK

13 COUNTIF

14 COUNTIFS

15 COVARIANCE.P

16 COVARIANCE.S

17 DEVSQ

18 EXPON.DIST

19 F.DIST

20 F.DIST.RT

aa EINV
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Click on function of interest and the Formula Builder will appear on the right.

~ Share A

41 Precocent — —_
Define Name * R - 5 Caleulane Now

- B, - -
(% Trace Dependents s o

Show Error Calculation | = Calcuane Sheoet

1 Croate from Selection .-
s X Remove Arows T formulas Checking Opticns

3 G b Formula Builder
Show All Functions

AVERAGE

—
.

Rosut {..) Dore

[« AVERAGE

Retums the avorage @1thmetic mear) of its
APUTONts, Which Can Do NUMDS OF NAMos,
ATy, o references that contan numbes

Symax
AVERAGEnumber! sumbe?... |

o Number!: numdor] rumber?, . am 110255

More help on this funcson
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For more information about that function, click “More help on this function” (in green on the bottom right of
previous picture) and a window with more detailed information will appear:

L Ewcel Hep

AVERAGE function

This article describes the formula syntax and usage of the AVERAGE function in Microsoft
Excel

Description

Returrs the average [arithmetic mean) of the arguments. For example, If the range AT A0
CONLANS numbers, t™he formula «AVERAGE(A 12A20) retums the average of those numbers.
Syntax

AVERAGE[numiber 1, [number2], )

The AVERAGE function syntas has the following arguments

« Numberl Reguiced. The first number, coll reference, or range for which you wast the

werage
+ Number2, Optonsl Addtional rumbery, cell references or ranges for which you want
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2.6 Sorting

Excel lets you sort the data in your spreadsheet by the entry in one column while retaining the integrity of the
entire profile for each record.

Preliminary - Before sorting, highlight ALL of the cells that are to be sorted; this is usually the entire
worksheet (recall — to select the entire worksheet, click on the triangle at upper left). The whole
screen will turn light blue.

gradel grade3

grade2
88 95 79 87.333333
79 90 77 82
92 88 83 87.666667
90 84 65 79.666667
87 89 76 84
95 94 88 92.333333
82 83 75 80

Again, there are at least two ways to do a sort, depending on the toolbar you choose to use.
Approach 1

From the Excel MAC Menu Bar: DATA > SORT. The following “Sort” window will appear. Check that
the box next to “My list has headers” is checked.

0.0.0 Sort |
Add levels to sort by: ™ My list has headers
Column Sort On Order Color/Icon
Sort by Values AtoZ
|+ | = | Copy|
Learn about sorting | Options... | | Cancel | [ oK ]
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Choose your sort. Here, I chose to sort the data by the entries in the column “Student”, alphabetically,
Ato Z. Click OK.

0.0.06 Sort
Add levels to sort by: o My list has headers
Column Sort On Order Color/lcon
Sort by v Student Values AtoZ
gradel
grade2
grade3
(Column E)
[+ = [ Copy]
Learn about sorting | Options... ‘ | Cancel | [ OK ]
Voila!
A..l..8B J. € .D. | NS —-—
Student gradel grade2 grade3
hua 87 89 76 84
jane 88 95 79 87.333333
joshua 82 83 75 80
kamil 92 88 83 87.666667
linda 90 84 65 79.666667
rober 79 90 77 82
zeke 95 94 88 92.333333
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Approach 2

From the DATA tab on the ribbon.
Click on the sort icon at the middle:

3. Excel MAC 2016 for Epidemiology Page 32 of 51

The tab is expanded.

Home Insert

Page Layout

N
-~

Review View Developer

A ¢

Formuias

-~

< | Connections ~
olear f ]

»"“ § = = & ] v/

= 5_ =_ -_’ Properties — =

From From New Database Refresh — i + Sort Filter ?, Advanced Text to

HTML  Text Query All cait Links = Columns
A

Cc2 v fx 95

The window below will appear. Choose your sort. Again, I chose to sort the data by the entries in the
column “Student”, alphabetically, A to Z. Click OK.

0,006

Sort

Add levels to sort by:
Column

v Student
gradel
grade2
grade3
(Column E)

Sort by

|+ - [ Copy |

Learn about sorting

Data
Collection

Management

™ My list has headers

Order Color/lcon

AtoZ

Sort On
Values

OK

J

| Options... | | Cancel | |

Statistical  ...... Reporting

Analysis

Data
Summarization

Data
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Voila!
A B & D E F

Student gradel grade2 grade3

hua 87 89 76 84
jane 88 95 79 87.333333
joshua 82 83 75 80
kamil 92 88 83 87.666667
linda 90 84 65 79.666667
rober 79 90 77 82
zeke 95 94 88 92.333333

2.7 Auto-filling (eg, 1 1 1, etc) and Fill Series (eg 1,2 3, etc)
Auto-Filling

Excel has an auto-filling feature that lets you replicate a given entry into multiple cells in a column.
This can be very handy.

Example Suppose you would like to replicate the A2 cell entry of “2009” into cells A3 through A150.
Step 1:  Enter 2009 in cell A2. Press enter. Select the cell A2 again.

Step 2: In the now active cell A2, position your cursor at the lower right corner of this cell so that the
cursor arrow changes to a small black cross.

Step 3: Click one time on the small black cross. Without releasing, drag down A3, A4 and so on to A150.

Step 4: When you release the mouse, notice that all highlighted cells now contain 2009, and a small auto-fill
options button appears. This brings us to Fill Series.

Fill Series (eg 0, 5, 10, 15 and so on....)

Excel can also save you time if you need to enter a regular series of numbers, days of the week, etc. Choosing

the Fill Series option in the example above will result in the series 2009, 2010, 2011, etc., adding 1 to each
successive cell.
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Example — Suppose you want to add 5 to each successive cell down a column, starting with 0.

Step 1: Enter 0 in cell B2, 5 in cell B3 and 10 in cell B4. Enter.

Step 2: Now highlight all three cells: B2, B3, and B4. Again, position your cursor at the lower right corner
of this cell so that the cursor arrow changes to a small black cross.

Step 3: Click one time on the small black cross. Without releasing, drag down B5, B6 and so on

Step 4: When you release the mouse, Excel will fill in the series for you!.

fun series
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2.8 Page Setup and Printing

Before you do any printing, specify your page layout. From the top menu, choose File>Page Setup Four tabs
with a variety of menus will appear: (1) Page, (2) Margins, (3) Header/Footer, and (4) Sheet

Page: Choose page orientation (Portrait or Landscape). If you do not have too many columns, choose the
option Fit to 1 page wide by 1 tall so that all of your variables appear on one page.

Margins  Meader/Footer  Sheet

Orientation
T * Portrait T Landscape
Scaling
* Adjustto: 100 ° % normal size
Fit to: Pages wide by 1 Tall

First page number:  Auto

Cance oK

Design ...... Data  ...... Data ... Data ... Statistical ...... Reporting
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Margins: In the margins tab you can choose margins and centering.

Page Setup
Page B Header/Footer  Sheet
Top: Header:
0.75 <) |03
Left: Right:
o7 v 0.7*
Bottom: Footer:
0.75* < 03
Center on page:
Horizontaly
Vertically

Header/Footer: Use this tab to specify custom headers and footers. A good practice is to use headers and
footers to document your name, date, file name, analysis code program names, etc.

Page Setup

Page  Margns [TTSICSTIg Sheet
Header:

(rone)

©

Custom Header, Custom Footer..

Footer:

{rore) H

Different odd and even pages
Different first page

Scale with document

Align with page margins

Design ...... Data  ...... Data ... Data ... Statistical ...... Reporting
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Sheet: Tip!! Use this tab to choose rows to be repeated at the top of each printed page and columns to appear
at the left of each printed page. The Sheet tab also allows you to choose whether or not to show
Gridlines in your printed table.

Page Setup

Page Margins  Header/Footer ﬁ

Print area:

Print Titles
Rows to repeat at top:
Columns to repeat at left:

Print Options
Gridlines Comments:  (None)
Black and white
Draft quality
Row and column headings

Page Order

© Down, then over I/l
Over, then down

Cance:

To preview your print out:

From the main menu bar: FILE > PRINT > PREVIEW

To print:

From the main menu bar: FILE > PRINT
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2.9 Handy for BIOSTATS 540 — How to Concatenate

Introduction — Why do I want to Concatenate?

In BIOSTATS 540, a number of online statistical software applications are introduced. These are terrific in
that you can enter your data directly! The problem is that, sometimes, the required format of data entry is

awkward. Two such online statistical software applications are:

1. Shodor Interactivate Box Plot
(http://www.shodor.org/interactivate/activities/BoxPlot/)

Enter your cata below, one per line Update Box Plot Clear

7066, state
10830 s2ate
6261 state
7504, state
8067 state

© Shodor

2. StatKey
http://www.lock5stat.com/StatKey/

What a nuisance! In both instances, when the data consists of two variables, one qualitative and one quantitative,
each row must contain the two values and they must be separated by a comma.
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Solution — Enter your data into Excel for pasting into Shodor or StatKey or whatever else

Example —
Suppose we want to enter the following data into our online statistical software application

Male, 44
Male, 16
Female, 37

Step 1

Launch Excel. Into Column A of your worksheet put your values of your first variable. For example, this
might look like:

COLUMN A

Male

Male

Female

Step 2

Into Column B of your worksheet put your values of your second variable. For example, this might look like:
COLUMN B

44

16

37

Step 3
Now position your cursor in COLUMN C, row 1. Into the formula box, type the following, taking care not to
forget the equal sign:

= concatenate(Al,”,”,B1)

You should now see in Column C, row 1:
COLUMN C
Male, 44

Step 4
Using copy>paste, repeat for the remaining rows of data.

All set!
Paste column C where you need it (StatKey or Shodor, etc)
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3. Excel MAC 2016 for Epidemiology

3. Data Set Creation Basics

Example (“ICU Example”)-

Page 40 of 51

In BIOSTATS 540, a study was introduced of 25 consecutive patients entering the general medical/surgical

intensive care unit at a large urban hospital. For each patient, the following data were collected.

Variable Description Code

ID Confidential Patient Identifier

AGE Age (years) numeric

TYPE_ADM | Type of Admission 1 = emergency
0 = elective

ICU_TYPE ICU Type 1 = medical
2=surgical
3=cardiac
4=other

SBP Systolic Blood Pressure (mm Hg) numeric

ICU_LOS Number of days in ICU integer

VIT_STAT Vital Status at Discharge 1=dead
O=alive

We’ll use this example of 25 observations to illustrate the steps and recommendations for data set creation

using MS Excel. The data are on the next page (page 41).
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Example (“ICU Example”) — Data.

id age type adm icu type sbp icu los vit_stat
1 15 1 1 100 4 0
2 31 1 2 120 1 0
3 75 0 1 140 13 1
4 52 0 1 110 1 0
5 84 0 4 80 6 0
6 19 1 1 130 2 0
7 79 0 1 920 7 0
8 74 1 4 60 1 1
9 78 0 1 920 28 0
10 76 1 1 130 7 0
11 29 1 2 90 13 0
12 39 0 2 130 1 0
13 53 1 3 250 11 0
14 76 1 3 80 3 1
15 56 1 3 105 5 1
16 85 1 1 145 4 0
17 65 1 1 70 10 0
18 53 0 2 130 2 0
19 75 0 3 80 34 1
20 77 0 1 130 20 0
21 52 0 2 210 3 0
22 19 0 1 80 1 1
23 34 0 3 920 3 0
24 56 0 1 185 3 1
25 71 0 2 140 1 1
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3.1 Design Your Database First

Before entering data into an excel spreadsheet, or any database application, the file's structure must be defined
first. Exactly how this is done varies by software type, but the following components are available in good
database software:

. Name of field (note — this is also your variable name) -- a single word name used as a shorthand
reference for a field
Keep it short (8 characters or under is recommended, though not required)
Avoid special characters such as #, -, *,... While some software will allow these special characters in a

name, others will not, creating problems when you transfer data between formats. Avoid spaces in a
name for the same reason. Use an underbar () in place of a space.

. Label for field -- (optional) a longer description of data stored in the field.

. Type of field -- there are 2 basic types of fields that dictate the manner is which data is stored,
character and numeric. Other field formats are often available, too. (e.g. date).

Numeric -- containing only numbers

Text or Character -- allowing letters, numbers, other keyboard characters
Other field types:

Logical -- Yes/No or True/False

Date -- containing dates in a specified format
(in some programs dates are stored as character data, in others, numeric)

Some programs have other special field types — currency, percent, phone numbers, SSN, ...

Note - In some software these are considered formats rather than field types.
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. Format for field -- specifies the number of digits or spaces available for entering and displaying data,
or other specialized formats.
Numeric formats specify the number of digits before and after the decimal place
Character formats typically define the number of spaces or columns needed

Date and Date/Time formats specify the order (month/day vs day/month) and presentation of data,
e.g., 07JUN2001 vs 06/07/2001

Data type

It is necessary to define the data type for each field. In Excel this is formatting cells (see page 21)

o Numeric and character data are stored quite differently, and you should be clear ahead of time, as to
data the type required.
o Numbers can be stored in character fields. Don’t do this!! It can cause great confusion later in the

data management process if you think you have numeric data and attempt computations, when the field
was defined as character.

° It is not always obvious when data should be numeric, and when character. For example, while a
phone number or social security number could be entered as numeric data, you will never want to
compute with these numbers -- they serve as ID or identifier types of variables. By entering these as
character data, you can include hyphens (e.g., 545-1000 or 999-99-9999), and when printed they will
appear in a familiar format.

o There are also occasions when numbers are clearly codes and can be entered as character data since
you will never compute with these numbers (such as 1=White, 2=Black, 3=Asian, 4=other). However
in some situations it may be advantageous to enter these as numeric data. Some statistical applications
(e.g., Minitab) will not allow character variables in analyses -- even if the variable is used solely to
define groups. If you know this is true of the software you will be using for analysis — plan
accordingly. If you have defined a variable as character and need numeric data or vice versa, it is
always possible to convert the data, or create a new variable in the required format from the values of
the current one, but planning ahead saves work.

o Pay attention to dates — some applications store dates as character data, and others as numeric. This
affects how information is transferred between programs, and you will often need to do some special
programming to handle dates. This is particularly important if you will be using dates to compute
durations (e.g., length of stay in hospital, time between patient interviews, etc...)
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3.2 Data Entry
The steps are best explained in an example.
ICU Example -
Step 1: Launch MS Excel

Suggestions:

Click VIEW TAB

Click on the NORMAL icon on the left
In the middle: ZOOM > 150%

You should see an empty spreadsheet and the cell A1 with a bold border.
Cell Al is the active cell; your cursor (you can’t see it actually) is positioned here.

Home Insert Page Layout Formulas Data Review Developer
v Formula Bar Zoom 150% =

Normal Page Break Page Custom v Griglines v/ Headings Q Zoom to 100% Freeze Freeze Freeze First
Preview Layout Views Panes Top Row Column

Al : fx

A B

1
2
3
4
5
6
7
8
9

[
o
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Step 2: Enter your variable names, horizontally, across row 1 as the column headings. Excel calls these
fields.

Proceeding horizontally across the first row, type the variable names in cells A1, B1, ..., G1. Use the right
arrow key after each entry so that your cursor moves right along the horizontal. You should now have the
following.

A A D 7 7 F 7 G
type_adm icu_type sbp icu_los vit_stat
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Step 3: Enter your data, column by column

To do this, begin by highlighting cell A2. Type a “1” in this cell (this is value of ID for the first record).
Press ENTER. Enter your data column by column. When you are done, you should now have the following;
note — Only a partial picture is shown here.

Edit Font Aignment Number

= , & Fum~ Calibri (Body) v[12 |v||AsAx| i | FE = (&= abc~  JWapText v  General N }

Pte P e~ (Bl I U | (SLAL EEIE/EIE/ | v - B %] 2 (%3 conuo
114 0O fx

| A B C D E F G H

1 id age type_adm icu_type sbp icu_los vit_stat

2 1 15 1 1 100 4 0

3 2 31 1 2 120 1 0

4 3 75 0 1 140 13 1

5 4 52 0 1 110 1 0

6 5 84 0 4 80 6 0

7 6 19 1 1 130 2 0

8 7 79 0 1 90 7 0

9 8 74 1 4 60 1 1

10 9 78 0 1 90 28 0

11 10 76 1 1 130 7 0

12

3.3 Formatting Fields, Field Names and Format Type
Step 4: Assign format types using instructions on page 21

(1) For each column, select the entire column
(2) From the toolbar at top, click on FORMAT. From the drop-down menu, click on CELLS.
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Example, continued —
The following are reasonable choices. Tip! Note that, except for the variable ID, I chose to format each

variable as numeric. This makes programming convenient, as it spares having to remember special

3. Excel MAC 2016 for Epidemiology

conventions in working with character fields.

Page 47 of 51

Column Variable Format cells category: Notes

A ID General

B AGE Number At right in the decimal places
box, choose “2”

C TYPE ADM Number

D ICU _TYPE Number

E SBP Number At right in the decimal places
box, choose “2”

F ICU LOS Number

G VIT STAT Number

You should now have the following; note — A partial picture is shown here.

(=] Font Asgrment Number

H“\ ., & Fm~  Caibri(Body) * 12 v A~ A~ (& abcr | JWmpText v  General . ’ .

Pute A/ Cew~ B I U S AL S EE e B %, 0 (%88 :
K20 X v Ix

4 A B C D b b G H

1 id age type_adm icu_type sbp icu_los vit_stat

2 1 15.00 1.00 1.00 100.00 4,00 0.00

3 2 31.00 1.00 2.00 120.00 1.00 0.00

4 3 75.00 0.00 1.00 140.00 13.00 1.00

5 4 52.00 0.00 1.00 110.00 1.00 0.00

6 5 84.00 0.00 4.00 80.00 6.00 0.00

7 6 19.00 1.00 1.00 130.00 2.00 0.00

8 7 79.00 0.00 1.00 90.00 7.00 0.00

9 8 74.00 1.00 4.00 60.00 1.00 1.00

10 9 78.00 0.00 1.00 90.00 28.00 0.00

11 10 76.00 1.00 1.00 130.00 7.00 0.00

12 11 29.00 1.00 2.00 90.00 13.00 0.00

13
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3.4. Creating New Variables Using Formulae and Functions
Suggestion: As a general rule, it is recommended that you do not do variable creations in Excel.
The advice is to reserve Excel file work for solely the raw data and that all new variable creation
occurs in the software you are using for data analysis (e.g. R or Stata)

See again section 2.5, beginning on page 22.

Example (“ICU Example”)—

We don’t actually need to create a new variable, but let’s do one for illustration. Suppose we want to create a

new variable called AGEDAYS with the following definition:

AGEDAYS = AGE * 365.25

Step 5: Create AGEDAYS in Column H.

(1) Incell H1, enter the variable name agedaysa

(2) In cell H2, enter the calculation of agedays for the first record by typing
= B2*365.25 Press enter. You should see the result 5478.75 in cell H2

(3) Highlight cell H2. From the menu bar: EDIT > COPY. The border of cell H2 should now be dashed
and vibrating!!

(4) Highlight cells H3 through H26. From the menu bar EDIT > PASTE

Your worksheet should now look like the following (this is a partial screen capture)

Design ...... Data  ..... Data ... Data ... Statistical ...... Reporting
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3.5. Documentation with a Data Dictionary/Coding Manual

Include in your Excel file a worksheet that is a coding manual for the data. Document in the coding manual
variable names, labels, type, value labels and a notes/remarks column.

Tip! Be sure to include missing value codes.

Tip!! How to get the carriage returns within a cell in Excel for MAC-

Notice that the entry in cell D7 has carriage returns. This was done as follows.
(1) Position cursor in cell D7

(2) After typing 1=emergency, do NOT press the enter key. Instead
press CONTROL - COMMAND -ENTER

Data
Collection

Data
Management

Data
Summarization

Statistical
Analysis

Reporting
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Example —
Sheets
<> A B C | D | E
1 Coding Manual ICU Study (n=25)
2 version 9-29-2011
3
4 Vvariable Label Type Coding Remarks
5 id Patient id character 1, 2, etc
6 age Age at admission, years numeric .=missing
1=emergency
O=elective
7 type_adm Admission type numeric .=missing
1=medical
2=surgical
3=cardiac
4=other
8 icu_type ICU type numeric .=missing
9 sbp systolic blood pressure, mm Hg|numeric .=missing
10 icu_los Length of Stay ICU, days numeric .=missing
1=dead
O=alive
11 vit_stat Status at discharge numeric .=missing
12 agedays New variable for laughs numeric age*265.25
3.6. Saving and Exiting
Before exiting, lets give names to the worksheets and reorder them.
Rename worksheet
(1) Position cursor on the tab located at the bottom of your screen
(2) Right click > RENAME
(3) Type in the new name. Press ENTER
Rearrange the worksheets
(1) Activate the worksheet you want to move
(2) Position cursor on the tab at the bottom of your screen
(3) Right click > RENAME
Design ...... Data  ..... Data ... Data ... Statistical ...... Reporting
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Example —

| coding manual raw data _+

o EE

Normal View Ready
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